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This article, at https://3nt.xyz > About, is now the official home of this
material (long ago published at MIT). Look for updates here.

« Most of the MS Office documents about the game of bridge use the
free Cards font. Starting in 2018, this font is also used in writing up
deals with Bridge Composer.

« Many of the Portable Bridge Notation (PBN) files on this site were
created or edited with BridgeComposer; some were created with
Dealmaster Pro.

. Items are noted (I) when appropriate for Intermediate players, or (A)
for Advanced or Advancing players.

« Titles of mainstream articles are bold, while more esoteric or less
important titles are in italics.

« The PDF files should be complete and need only Acrobat Reader. That
is, all necessary font components are embedded in the files.

Embedding fonts. Assure that MS Word embeds all fonts used, in their
entirety, before creating a PDF to post:

1. In MS Word: File > Save [bottom left]

2. The settings will come up for the current document; change to All New
Documents; then check the first box and make sure the other boxes
are not checked:

Preserve fidelity when sharing this document: @ All Mew Documents -

~| Embed fonts in the file D
Embed only the characters used in the document (best for reducing file size)

Do not embed commen system fonts

3. Click OK.

Open each existing document — especially any that is used as a template —
and perform the steps above for that specific document.

This is a pernicious problem, because people who do not have a font used in
a posted PDF may either see nothing for characters in that font, or suffer
some probably-ugly font substitution. They might be on a Mac or Android.

Revisit these settings for a new version or reinstall of MS Office.

My circumvention is to create a simple file called Title.docx — complete with
proper font settings — that | copy and rename to start a new article. It might
be possible to use a MS template instead of a personal one — YMMV.


https://3nt.xyz/
http://www.pagat.com/com/cardsttf.html
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Media Codes

To describe attributes of the intended media, PDF documents are noted
with these Media Codes:

Media Size Description

Portrait orientation, 1-2 columns, US Letter, usually single column,
8.5"W x best for printing and viewing on a moderate to large screen. Articles
11"H published before July 1, 2018 and most other bridge material is in this
format.

11"W x Landscape orientation, 1-2 columns, US Letter. Appropriate for the
8.5"H  occasional spreadsheet that is too wide for some other format.

Portrait orientation, 1 column, US Junior (Half Letter or Digest). Best
viewing on a small screen; good for large print on letter paper, or
printing a booklet on Junior size (or larger print on larger paper).

5.6"W x Proper printing requires downloading the PDF and printing with

8.5"H Acrobat Reader, as described in Printing Media J or T Documents
(About > Print Media J). All articles published between July 1, 2018
and June 9, 2021 should be Media J. [With adjustments, could be best
for publishing a book in Digest format (5.5” x 8.5”).]

Portrait orientation, 1 column, US Letter. Best viewing on a small
screen; best for large print or publishing as a book in US Letter (8.5” x
6.9”W x 11”) format; also good for printing a booklet in Junior format (5.5” x
11”H 8.5”). Printed results are intended to be equivalent to Media J, and
downloading the PDF is not required. Articles published after June 9,
2021 should be Media K. (Code K- is narrower, for a print book.)

Portrait orientation, 1 column, US Trade. Best viewing on a small
5.2”W x screen and good for printing; best for publishing as a book in US Trade
9”H (6” x 9”) format. Before 20 June 2023, page width 6.0”, inside margin
1.0”, outside margin 0.7” =

.\ Portrait orientation, 1 column, Executive. Good viewing on a small
5.65"W . i . .
X Y screen and good for printing; best for publishing as a book in Executive
x 10”H ” )
(7” x 10”) format.

Note: | invented these codes for use on this site.

Media K for Articles Going Forward

This document is an example of the Media K format adopted for articles on
3nt.xyz in June 2021. Microsoft Word is used to create the document, which
is then saved and published in Portable Document Format (PDF). It meets
these requirements for the document:

e Easyto read on a small screen, such as a smartphone.


index.html#PrintJ

e Large print on standard letter paper in portrait orientation.
e Normal print on letter paper with two pages on one side (2-up).

Media K supersedes Media J, which met all the requirements above, but had
a significant shortcoming for the reader: proper printing required first
downloading the PDF and then opening it with Acrobat Reader. Printing
Media J (or T) directly from a browser could result in half-size print in the
upper left corner of the page.

Media K should allow proper printing from the web, without downloading.
This has been accomplished by changing the format of the document in
Word to produce a larger print document. The stated margins are small, for
the sake of the small screen.

Word is told to use the full 11 inch height of the paper, but only 6.9 inches
of width. When a Media K PDF is printed, this narrow page gets centered on
the 8.5 inch page, producing desirable print margins. This centering also
applies usefully within the area for a single page, when printing 2-up.
Unfortunately, that area has different proportions from a full letter sheet, a
defect of US Letter (A size) paper.

On international A4 paper, | expect the results would be acceptable. If you
cut an A4 sheet in half, the resulting A5 sheets have the same proportions,
with the width 70% of the height.

Document Styles and Page Layout in MS Word

Heading Font

Microsoft’s default heading font is Cambria, which I did not like — as |
recall, I mostly took issue with spacing between characters in actual
headings - you are reading it in this paragraph.

Instead, I like Sitka Heading - you are reading it in this paragraph and
in the major headings of this article. I consider this a done deal. I selected
it before I investigated the Sitka font family thoroughly (below).

Alternative Heading Fonts. Arial was my choice before | switched to
Sitka Heading; regular Arial headings are a little tired, but the italic is
very good — you are reading it.

Source Serif Pro is very good, but the italic is a little busy - you are
reading it.



Text Font

For a PDF that will primarily be read online, | have been an advocate of
Calibri, the default text font in Microsoft Word — you are reading it now — it
is also used in minor headings in this article. Calibri is a sans-serif font,
which research finds is better for reading on a screen.

For a book or other printed text, comprehension 1s improved by the
ornamentation of a serif font such as Times New Roman, which you are
reading now. This font was commissioned by British newspaper The Times
in 1931 and is an obvious default serif font. It’s a relatively small font for a
given point size, but has the major advantage of having a footprint close to
that of Calibri, without exceeding it in either height or width. I think it’s OK.

The Sitka Font Family. Sitka was designed and scientifically tested to be
readable, especially on a screen. Each of the six fonts is intended to be used
for a narrow range of sizes. Most of the testing was done with Sitka Small,
since improving the smallest fonts might provide the most benefit.

The testing was done by having a character pop up in a marked location on a
screen for a short duration (less than a second). The tester would then
press the key for the letter — the tester and timing were calibrated
beforehand, intending to achieve 50% accuracy. Tests were done with lone
characters and with unrelated characters to both left and right. Because
they did not test with characters above and below — let alone varied
distances above and below — | have concluded the testing was flawed. Here
is what happens when you print all six fonts at 11 points (pt). [There are 72
points per inch.]

Sitka Small (for 0-9.5 pt) 0123456789
The quick brown fox jumps over the lazy dog. 3.50” W
The QuIcK bRoWn FoX jUmPs OvEr ThE 1AzY dOg. 0.77" H
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.
Sitka Text (for 9.5-13.5 pt) 0123456789

The quick brown fox jumps over the lazy dog. 3.25” W
The QulcK bRoWn FoX jUmPs OvEr ThE 1AzY dOg. 0.77” H
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.
Sitka Subheading (for 13.5-18.5 pt) 0123456789
The quick brown fox jumps over the lazy dog. 3.03” W
The QulcK bRoWn FoX jUmPs OvEr ThE 1AzY dOg. 0.77” H
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.
Sitka Heading (for 18.5-23.5 pt) 0123456789

The quick brown fox jumps over the lazy dog. 2.88” W
The QulcK bRoWn FoX jUmPs OvEr ThE 1AzY dOg. 0.77” H
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.




Sitka Display (for 23.5-27.5 pt) 0123456789
The quick brown fox jumps over the lazy dog. 2.72” W
The QulcK bRoWn FoX jUmPs OvEr ThE 1AzY dOg. 0.77” H
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.
Sitka Banner (for 27.5-00) 0123456789

The quick brown fox jumps over the lazy dog. 2.62” W
The QulcK bRoWn FoX jUmPs OvEr ThE 1AzY dOg. 0.77” H
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.

Times New Roman (11.5 pt, for comparison) 0123456789
The quick brown fox jumps over the lazy dog. 2.92” W
The QulcK bRoWn FoX jUmPs OvEr ThE 1AzY dOg. 0.73” H
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.
Calibri (11.5 pt, for comparison) 0123456789

The quick brown fox jumps over the lazy dog. 2.91” W
The QuicK bRoWn FoX jUmPs OvEr ThE IAzY dOg. 0.79” H
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.

Those Sitka digits are probably good, unless you have lots of numbers or
tables of numbers. After building this table in another file, | printed it
directly from Word and measured it. W was the width of “The quick brown
fox jumps over the lazy dog.” And H was the height of the current row, line
to line. They cheated!

All six Sitka fonts have the same line height, but the character sizes on the
line differ. The characters intended for small use are bigger — of course
they are easier to read, with nothing above or below them. However,
paragraphs contain multiple lines — look at how little white space is there
between the lines of Sitka Small, compared to the fonts moving down the
list to Sitka Banner. White space definitely makes a difference in
comprehension.

There may be minor tweaks to different fonts, but this size difference is
fundamental. Just because the design says Sitka Text is best for 11 pt
paragraphs does not make it so. For this use, my choice is Sitka Heading,
which at 11 pt has the closest footprint to 11.5 pt Calibri or Times New
Roman. Sitka Subheading would take more space (width), and Sitka Display
would take less space — either could be appropriate. None of the other Sitka
fonts appeals to me around 11 pt.

Alternative text fonts. Of all the other Serif fonts on my computer, only
Georgia made my short list — you are reading it — I find it too tall.



Back-matter font. In my books, | use Sitka Heading as the primary font. In
Bidding Tools, | decided to switch to a second, sans-serif font for the back
matter sections at the end of each topic — after most of the work was
already done. My short list included Source Sans Pro (an open-source font
from Adobe, possibly called Source Sans in Windows 11), Corbel and Calibri
(Microsoft Cleartype fonts). Source Sans Pro has an almost identical
footprint to Sitka Heading; it seems occasionally to be a few hairs narrower
on a line. It seemed to read better than Calibri, my third choice. Corbelis
smaller than Sitka Heading in each direction; it printed my first test page
with 6.7” of text, requiring one fewer lines. With Sitka Heading or Source
Sans Pro, the text was 7.05” tall. The Source Sans Pro characters are taller
within their given space, making them more readable in isolation, but
reducing white space between lines. Corbel was my first choice, because
digits are more compatible with Sitka Heading — but then | hated the
computer-geek quotation marks and other aspects. It was small work to
switch to smaller Calibri, which proved very good. | exported this file to a
PDF, printed the following table (actual size) from within Acrobat Reader,
and measured the second line in each box, as shown.

Sitka Heading (10.5 pt) 0123456789

The quick brown fox jumps over the lazy dog.

The QulcK bRoWn FoX jUmPs OvEr ThE 1AzY dOg.
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.
Corbel (10.5 pt, for comparison) 0123456789

The quick brown fox jumps over the lazy dog.

The QulcK bRoWn FoX jumPs OvEr ThE IAzY dOg.
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.
Source Sans Pro (10.5 pt, for comparison) 0123456789
The quick brown fox jumps over the lazy dog.

The QuicK bRoWn FoX jumPs OvEr ThE |AzY dOg.
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.
Calibri (10.5 pt, for comparison) 0123456789

The quick brown fox jumps over the lazy dog.

The QulcK bRoWn FoX jUmPs OVEr ThE IAzY dOg.
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG.

2.72” W

2.68” W

2.71" W

2.66” W

Hyphenation — Bridge.

RKB ask — not RKB-ask

gueen ask — not queen-ask

trump-queen ask — not trump queen-ask — asking if partner has the trump queen
specific-king ask — not specific king-ask — asking partner to show a specific king
second-king ask — not second king-ask — asking partner for another king (the issue)
third-round-control ask — not third-round control ask or third-round control-ask
two level (noun, never a digit), two-level (preferred adjective) or 2-level

two-bid, one-suiter



Footer Space

In early 2022, | finally got a handle on how footer space works. The bottom
margin defines, as a distance from the bottom of the page, the lowest point
on the page below which the body text will not intrude. To set this:

Layout > Page Setup > Margins > Bottom:

The footer space is also defined by a distance from the bottom of the page,
overlapping the margin space:

Layout > Page Setup > Layout > Footer:

That distance defines the baseline of the last line of the footer. (Characters
may descend slightly lower.) The height of the footer is determined by the
height of its contents. If the footer extends above the margin, Word extends
the effective bottom margin.

Since we want every page to have the same effective bottom margin, it’s
best to set a bottom margin that completely contains all footers to be used,
including space between the footer and the body. The typical footer would
contain exactly one line, whether empty or filled — or there might be no
footer at all.

Earlier versions of this article — and all my documents published before April
2022 — use footer space determined by trial and error. For this article:

Layout > Page Setup: Prior Version Current Version From Title.docx

Margins > Bottom: 0.5” 0.75” 0.20”

Layout > Footer: 0.2” 0.38” 0.40”

Footer contents: Page number on middle Page numberon  Page number on
of three lines (~0.75"). one line (~0.25”). first of two lines.

Footer base + height:  0.95” 0.63” 0.60”

Actual bottom margin: 0.95” 0.75” 0.75”

(While 15 points is 0.21”, the full line height is about 0.25” including space.)

In practice, it does not matter, but | failed to set the footer according to spec
in Title.docx, which has no footer text defined. | have been creating articles
from Title.docx; | fixed it as of 8 Jun 2023. The document you are reading
has the specs for the current version, with a page number in the footer.

Header Space

While | seldom use headers, | expect header space to work the same way,
but with the header distance specifying the distance from the top edge of
the page to the top of a capital letter (instead of to the baseline). I'll confirm
and update.



Media Layouts

My documents are intended to print with black ink only, although color may
be used in photos and some adornments. These document styles are used
to manage document elements for consistency:

Style Media K Media T Media J
Title 31 pt * black TBD 26 pt Cambria blue...
Heading 1 21 pt * black bold 19 pt * black bold 14 pt Cambria blue or
16 pt Arial black bold
Heading 2 18 pt * black bold italic | 16 pt * black bold italic | 13 pt Cambria blue or
14 pt Arial black b-italic
Heading3 § | 17 pt * black bold 15 pt * black bold 11 pt Cambria blue or
12 pt Arial black bold
Heading4 & | 17 pt * black bold 15 pt * black bold ... 14 pt Calibri bold
Heading 5 16 pt * black bold italic | TBD ... 13 pt Calibri bold
italic
Heading 6 15 pt Calibri black bold | TBD ... 12 pt Calibri black
bold
Normal 14 pt Calibri, 0 pt t 0 pt before, 0 pt after, | 11 pt Calibri, 0 pt
before, 10 pt after, line | line spacing 1 before, 6 pt after, line
spacing 1 spacing 1

* The heading font is Sitka Heading.
t The Normal text font for a book is 11.5 pt Times New Roman or 11 pt Sitka Heading.
§ Use Heading 3 (in the table of contents) or Heading 4, but generally not both.

Media K upsizes Media J by a factor of about 1.3, so that a basic print
method will fill the page, instead of printing in the upper left corner. Either
is eminently suitable for printing from Acrobat Reader, either to fill the page
(specify Fit) or “two up.” No new work is being done in Media J. The
settings for Media K were updated in April 2022, and Media X added in June
2023.

For printing a book from Media T or X, update (=) to the full paper width
and margins, including additional inside space for binding. If a book is not
intended, use Media K.

This Singing World was published using the Media T specifications at the
time. The tables below were updated for new books after 20 June 2023,
when Amazon KDP greatly increased printing costs for books with pages
larger than 6” x 9” (in either dimension). | was ready to go with Media X,
but reduced to Media T, as shown.




Measurement/Setting | Media K | Media T Media X Media J
Paper Size: 8.5”x11” | 6”x9” 7”x10” 5.5”x8.5”
Normal Font Size: 14 pt 11.5 pt 13.5 11 pt
Line Length: 6.9” 4.62" 5.25 5.0”
Text Area Height: 9.75” 7.6” 8.5” 7.8” max
Margins: Top 0.5” 0.6” 0.75” 0.3”
Margins: Bottom 0.75” 0.8” 0.75” 0.4”
Margins: Left/Inside 0.2” 0.2” - 0.78” | 0.2” - 1.00” | 0.3”
Margins: Right/Outside | 0.2” 0.2” 2> 0.6” [0.2” > 0.75” | 0.3”
Margins: Gutter: 0” 0” (do not use) 0”
Margins: Multi Pages: | Normal Mirror Margins Normal
Paper: Width 6.9” 5.02”>6" 5.67 2> 7.0” |5.6”
Paper: Height 11”7 9.0” 10.0 8.5”
Layout: Header 0.38” 0” 0.37” 0”
Layout: Footer 0.38” 0.4” 0.37” 0.2”
Layout: diff odd/even O ] M O

Book Info
My forthcoming bridge book will be published with the new Media T.

Book Size
When starting your book, do you care particularly how big the pages are?
Probably not, if you are writing “The Great American Novel.”

However, for poetry, technical data, bridge deals or anything else where the
presentation and pagination are key, you should decide the page size early.
This will smooth publishing. You can change later — as | have done multiple
times — but it’s work. Unlike when printing from Acrobat Reader, when
publishing a book, you cannot tell the service to resize to fit the paper size.

| have settled on Media T (US Trade). If you are not sure, start with Media T

and draft a typical chapter or two.

A mock book. In Microsoft Word, export your file to a PDF:

File > Export > Create PDF/XPS

File > Save As > PDF

[Office 2021]

[Office 2010]

Do not select any “smaller file” option — make sure all fonts are included.
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With the resulting PDF open in Acrobat Reader, start to print the file with
the printer icon or Ctrl+P, and specify options:

® Pages [print all, or list full-sheets — odd-even pairs]
® Actual size
M Print on both sides of paper © Flip on long edge

The printed pages should come out centered. We need to cut the sheets to
print size with care for the specified margins. We need some basic algebra
to calculate that, using our current US Trade dimensions:

W width of a sheet of paper=8.5 |H  height of a sheet of paper =11
inside margin =0.78 t top margin =0.6

line length = 4.62 a height of text area=7.6
outside margin = 0.6 b bottom margin = 0.8
trimwidth=i+1+0=6 h trim height =t+a+b =9
extra for binding=1-0 =0.18 | x extra for footer=b -t = 0.2
amount to cut from Inside T amount to cut from Top
amount to cut from Outside B amount to cut from Bottom

O~% s 0 —~ ~

I+0=W-w=25 [totalcutwidth) | T+ B=H-h=2 [total cut height]
O=1+x=1+0.18 ... substitute... | T =B + x = B + 0.2 ... substitute ...
I+(I+0.18)=25 21=2.32 B+(B+0.2)=2 2B=128
I=1.16 O0=134 Ocut=7.16 |B=0.9 T=1.1 Tcut=9.9

So cut 1.16” off the inside edge, and 1.34” off the outside. Similarly, cut 0.9”
off the bottom edge, and 1.1” off the top. Always ask, does this make
sense? Yes, we want to cut more from the outside and maybe the top, to
leave more space on the inside (for binding) and bottom (for the footer).
And our cuts will leave 6” x 9”. Draw a picture, if you don’t believe it.

A paper cutter is handy, as we can easily cut multiple pages at a time. Once
we have cut one edge, we just cut the opposite side to the net dimension. If
printed two-sided, the back should automatically be cut correctly.

Staple the sheets at the very edge, to simulate a binding. Hold the mock
book in your hands. Do you like it? Do you like the margins? Can you fit
enough on a page? Is it too dense? Get a similarly-sized book off your
bookshelf, and compare it to your mock book.

11




Book Survey.

External

- - (= -
s | ® 2 &
— X o

| 2|82/ .28 |2 |2§ s |55 ¢

Reference S W g 5 o | o 25 | o £ 5| @
~ (] 2 o o 0| £ = 3 ) =] £
1. (None) 6.97 | 4.17 PB 6.1 41 | 0.15 | 0.375 | 0.25 | 0.65* | 3.5
2. (None) 5.45 | 8.25 PB 6.35 | 30 | 0.21 0.8 0.7 1.1 3.9

3. (Precision) | 5.5 | 8.5 0.19 | 0.54~ | 0.85* | 0.5 | 4.25
4. (Expert) 6.0 | 9.0 . 0.79 1.0* | 0.95* | 4.3
5. (Peril) 6.87 | 4.2 PB 5.85 | 34 | 0.17 | 0.33 0.6* | 045 | 3.5
6. (Lawless) | 6.25|9.25| 895 | 705 | 34 | 0.21 | 0.75 0.9 0.9 | 4.25
7. (Singing) 55 | 82 | 795 | 55 33 | 0.17 1.1 0.8* | 1.6* 3.5
8. (Caution) 52 | 7.7 7.5 5.8 32 | 018 | 0.7 | 0.65 1.0 | 3.85
9. (Money) 6.2 | 9.5 9.2 | 725 | 31 | 0.23 | 0.75 |0.85*| 1.1* | 4.32
10. (MCB) 6.0 | 9.0 PB 7.85 | 46 | 0.17 0.4 0.5 | 0.65 | 4.85
This article (8.5)| (11) | 6.9 | 9.75 | 38 | 0.26 0.2 05 | 0.75 | 6.5
All values are in inches, except Line Count (per page). PB=Paperback.
* This margin contains a page number or line of text.
~ Varies around listed value.
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Discussion of Key Metrics. A lower line count per page is more pleasant to
read, but requires more pages to hold the material. More lines fit more on
the page, but can appear dense, putting off the reader. Extra white space
within the body can help with this. For a modern book, experts say the line
count should usually be 30 to 36 lines per page.

A greater line height is easier to read. The default in MS Word is to use a
line spacing of 1.15, which | set on this paragraph only. | mostly use 1.0,
single spacing, so for a given line height, | have taller characters, but less
white space between lines. | entered a test page using my usual 1.0 single
spacing, and it fit 38 lines on the page — fine for mostly online use. With
1.15 spacing, 33 lines fit (38/1.15, as expected), for a huge line height of
0.295”. This can be easier to read, but | won’t yield the space.

Discussion of the Books.

1. And Then There Were None, Agatha Christie; Pocket Book, 1944/1975. This paperback was
laid down during World War II; my copy is from the 46™ printing. The outside margin is
typical of a mass-market paperback. The price is kept down by having 41 lines on the page
(20% more than [5] P Is for Peril has in the same form factor). The tiny line height, which
Includes its share of white space between lines, is between a sixth and a seventh of an inch
— for young eyes, this is acceptable. The outside margin is about 2 % times the line height.
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A better allocation of space would move an eighth of an inch (0.125) from the bottom
margin to the top margin. With that done, the extra space for the page number at the
bottom would be the line height (0.15). The text of the book takes 165 pages.

. And Then There Were None, Agatha Christie; St. Martin’s Griffin. This copy is not dated, but
the printing count says 10 9 8; it has both ISBN-10 and ISBN-13, so this printing is probably
from about 2007. The line height is generous, more than a fifth of an inch. Although it has
37% larger print and far more whitespace than the Pocket edition, the quality of the paper
is the same — not a balanced upgrade. Move 0.1 from the bottom margin to the top, and
the extra space in the bottom margin for the page number becomes about the line height.
The text of the book takes 264 pages.

Precision Today, David Berkowitz and Brent Manley; DBM Publications, 2002. The line
height is less than a fifth of an inch, and the outside margin is less than three times the line
height. With those smallish margins and high line count, this book is quite dense. On the
other hand, you get more contents for your money.

Expert Bridge Simplified, Jeff Rubens; Bridge World Books, 2009. At 409 pages, this is a
heavy US Trade paperback. It is professionally designed to use the maximum recommended
36 lines per page and a comfortable outside margin. The text header and page-number
footer each add the expected one line of text to the margin space. We are talking
maximum practical density here — | like larger fonts, but not smaller margins or a heavier
book.

P Is for Peril, Sue Grafton; Ballantine Books, 2002. This modern pocket book has the
smallest outside margin of all these books. A bit more top plus bottom margin and
significantly more line height make it more pleasant to read than [1] And Then There Were
None.

L Is for Lawless, Sue Grafton; Henry Holt, 1995. The greater line size and generous margins
make this hardcover novel significantly easier to read than the pocket book. The text
header and page-number footer each add less than the expected one normal line of text to
the margin space, perhaps because the fonts used are smaller.

This Singing World, Louis Untermeyer; Harcourt, Brace, 1926. I'll discuss this poetry
anthology in great detail below. Moving 0.4” from the bottom margin to the top margin
would equalize the margins; each of the header and footer lines would then add only 0.1”
to the corresponding margins, compared to the expected 0.17”. This book has clearly been
painstakingly typeset, one page at a time. It has much in common with a pocket book, with
the addition of wider margins.

Captain Caution, Kenneth Roberts; Doubleday, Duran, 1934. This adventure book
impressed both my father and me in our youths. The print is smallish, but quite readable -
a solid step up from a pocket paperback. However, modern readers would expect larger
print, asin L Is for Lawless.

Money Magic: AN ECONOMIST’S SECRETS TO MORE MONEY, LESS RISK, AND A BETTER LIFE; Laurence J.
Kotlikoff, 2022. This book presents great ideas in an eminently readable format. The tall
line height includes extra white space between lines, rather than a taller font. If it was
produced with Word’s 1.15 line spacing, then single spacing would have produced 36 line
per page and a line height of 0.20” — ostensibly equivalent to [4] Expert Bridge Simplified.
However, the latter’s font appears slightly shorter and substantially narrower (even the
spaces are narrower), so it squeezes many more words on a line —it’s not as comfortable to
read as Money Magic.
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10. Modern Constructive Bidding; Marshall Miles, Masterpoint Press, © 2005. This book is well-
set, but is a little dense at 46 or more lines per page and narrow margins. This is not
unusual in modern bridge books, but it did not look well with bigger fonts.

Guidelines. Assuming that a header or footer will be exactly one line of text:

1. Calculate the line height of the text: Find a block of text, preferably a
whole page, that is in the Normal style and has completely consistent
line spacing. Measure the height of the block (include a few hairs for
the first line’s white space) and divide by the number of lines the block
contains.

2. Empty margins should be the same size, and two to four times the

calculated line height. (A larger margin appears more luxurious to the

reader, but it shrinks the text area.)

Plan to add space to the inside margin, for binding.

4. Increase a margin by the line height (or perhaps a little more), if a line
of text (header or footer) will be included in that margin on any page.

5. Specify half the margin for the header or footer location.

w

This method approximates the prominent modern style. It places the footer
line about one blank line below the last possible line of text on every page.
(A second choice would center the footer vertically in the bottom margin.)

For me, a half-inch margin looks too thin on a 6” by 9” page. Cramped for
space, | have chosen for Media T to replicate the 0.7” outside margin for the
top and bottom, whether or not a header or footer is present. My inside
margin of 1.0” is skimpy for binding, but this sort of compromise is common.

Header Space
Header space works similarly. The Header distance appears to be from the
top of a capital letter to the top edge of the paper.

Headings
Each chapter is a “Heading 1” and will likely have a number preceding its
name. Usually, the first topic in the chapter begins without further ado.

Each topic is a “Heading 2”. Subtopics are Heading 3 (in the TOC) or Heading
4 (expected sections such as Backstory, not in the TOC) — both otherwise the
same. Do not put a Heading style inside a table.

Most topics contain Backstory and Alternative Methods sections. The text in
these sections is Small-N, instead of Normal.
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Line Endings, Unbreakables, Dashes - Pavlicek Style
Mostly, | follow Richard Pavlicek’s Bridge Writing Style Guide. | use these
interpretations and exceptions:

Each suit, level or card rank is treated as a word, except in a table where
space is unusually tight. For example:

AA The preferred form for a card: the reader may choose to absorb
it by preference as “spade ace” or “ace of spades.”

2 A The preferred form for a bid, because it stands out in a
paragraph.

3¢6/390/3Q Describes any of these three bids, on one line of a table.

In flowing text, “2 s” (2 & using the Cards font) might be split across a line
ending. To avoid that, make the space nonbreaking, perhaps with:

Insert > Symbol > More Symbols... > Special Characters > Nonbreaking Space
nb space Use Ctrl+Shift+Space to insert a nonbreaking space.
nb dash Use Ctrl+Shift+Dash to insert a nonbreaking dash.

en-dash (-) Use the numeric keypad dash: Ctrl+{Num -}. The en-dash
separates suit breaks (3—2), point counts (18-19), etc.

em-dash (—) Use the numeric keypad dash: Ctrl+Alt+{Num -}.

Q@ K-10-2  Within a paragraph, separate cards in a single-suit holding with
hyphens. Pavlicek shows & A-K-J-3-2 © K-10-2 ¢ 9-8-7 ¢ 3-2
inline, but for me, a whole hand deserves at least its own line,
with three spaces between suits:

AAKI32 OK102 ©987 32
When feasible, put each suit on its own line.

1A —-1NT When giving an auction on a single line, bids within a round of
bidding are separated by an en-dash. A bid made by an
opponent is enclosed in parentheses. Within a paragraph, an
auction is {within braces}. When feasible, each round of bidding
is its own line, without braces, preferably in columns. A
comment on a bid is [in brackets].

keycard s a single word —I’'m with Eddie Kantar on this.

two level never a digit for a noun. Two-level (preferred) or 2-level is an
adjective.
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Section Breaks, Headers, Footers and Page Numbers
My style is fairly mainstream:

e A page on the right always has an odd number; a page on the left
always has an even number — whether or not that number is printed.

e The page number is in the footer at the bottom of the page, at the
outer edge of each page (away from the binding).

e Any footer text is on the line of the page number, separated from it by
ten spaces. If necessary, | abbreviate the expected footer text to fit on
the one line.

e For an even page, the expected footer text is the title of the book.

e For an odd page, the expected footer text is the title of the chapter,
usually followed by the topic, separated by an en-dash as a word (—).

This style is often implemented using the header instead of the footer,
especially for mass-market fiction. When chapter titles are of little or no
interest, the author’s name goes in the even header, and the title of the
book in the odd header. Yet another variation is to center page numbers in
the footer and center the text in the header; this consumes more space, but
is well-suited to content, such as poetry, that may be centered on the pages.

Start the book with one or more pages that are not numbered, such as the
title page. To create the empty footer:

Insert > Footer > Blank (Three Columns)
Press Esc to exit the footer.
To start numbering within the front matter, section break to a new page:

Layout > Breaks > (Section Breaks) Next Page

Breaking to an odd or even page has produced undesirable results for the possible
skipped page, so | never do that. Instead, | insert a regular page break ahead of the
section break, if necessary. This means | need to check pagination carefully — control,
but at a cost.

Open up the footer for the first page to be numbered:
Insert > [Header & Footer >] Footer > Edit Footer
which brings up the “Header & Footer Tools” tab.

Take care, because the pointer may jump back to the previous section.
If so, scroll forward and click in the footer of the new section.
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Important: make sure “Link to Previous” is not highlighted in the new
section. Otherwise, anything we do here will affect the previous
section as well. This highlighting has received a gratuitous change:

Office 2010 Office 2021
Highlighted (bad): Yellow Dark gray
Not Highlighted (good):  Gray (probably dark) Background gray

Headers and footers have separate “Link to Previous” settings.

We want the page number on the right-hand page for odd pages, and on the
left for even pages (or centered on all pages). Use

Page Layout > Page Setup > Layout
and select both “Different odd and even” and “Different first page.”
In the front matter,

Insert > Page Number > Format Page Numbers

and set the Number Format to “j, ii, iii.” Continue page numbering from the
previous section. However, do not number the very first page.

To start numbering the main body, section break to the next page (or odd
page). Open up the footer for the first page to be numbered, which brings
up the “Header & Footer Tools” (green tab).

Important: make sure “Link to Previous” is not highlighted.
Page Number > Format Page Numbers...

Set the Number Format to 1, 2, 3 and Start at 1.

On the first even page to be numbered:
Insert > Page Number > Bottom of Page

Select the first footer, simple page number on the left (outside). In the
footer for the page, put 10 spaces after the page number, and follow it with
the book title. Alternatives include using a three-section footer to center or
inside-adjust the text. A fancier footer, it may extend the bottom margin.

On the first odd page to be numbered:
Insert > Page Number > Bottom of Page

Select the footer to put a simple page number on the right. In the footer for
the page, put 10 spaces before the page number, and precede those spaces
with the section or chapter title.
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To start the next topic, section break to the next page or next odd page. On
the footer for the first odd page of the new topic, position the cursor at the
right of the previous topic title, which should be there, and backspace over
it. Then type the new topic title.

Important: make sure “Link to Previous” is not highlighted.

However, we do want “Link to Previous” for the even page footer, so
that the book title continues to appear on even pages. If this is done
properly, should the title of the book be changed, the even page

footer should require only one change.

Note: A single-even-page topic title won’t get into a footer. If the topic later

expands to a second page, then that footer will need to be fixed.

Up & Downsizing from & to Media T for Printing

Measurement/Setting | This Singing | Exec (X) TSW Bridge
World (T) Favorites (K-) | Books (T)

Paper Size: 6”x9” 7”x10” 8.25"x11” 6”x9”

Line Length: 4.3" 5.25” 5.6” 4.62”

Text Area Height: 7.6” 8.5” 9.4” 7.6”

Margins: Top 0.70” 0.75” 0.80” 0.6”

Margins: Bottom 0.70” 0.75” 0.80” 0.8”

Margins: Inside 1.00” 1.00” 1.55” 0.78”

Margins: Outside 0.70” 0.75” 1.10” 0.6”

Margins Gutter: 0” (do not use).  Multiple Pages: Mirror Margins.

Paper: Width 6.0” 7.0” 8.25” 6”

Paper: Height 9.0” 10.0” 11.0” 9.0”

Layout: Header 0.35” 0.37” 0.40” 0.0

Layout: Footer 0.35” 0.37” 0.40” 0.40”

Layout: diff odd/even 4| | 4] ]

Font size (pt) — Normal |11 13 14 11.5

Font size (pt) —Small-N | 10 11.5 13 10.5 Calibri

Font size (pt) — (smaller) | 9 10 12 10

Font size (pt) — (Footer) | 11 13 14 10.5 Italic

Font size (pt) — H1 19 24 — 20

Font size (pt) — H2 18 16

Font size (pt) — H3 16 14

Font size (pt) — H4 14 16 18.5 14

Font size (pt) — H6 12 [Poem?2] 14 14 [Poem?2] 12.5

Font size (pt) — HalfTitle | 16 18 - 18

Font size (pt) — Title 28 24

Font size (pt) — Subtitle 19 18
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When increasing from Media T (US Trade) to Executive or Letter (reduced to
8.25” wide), the limiting factor is the height. For example, the extra one-
inch of width in Media X (Executive) is 17% of the width, but the inch of
height is only 11%. When moving down from X to T, the width becomes the
limiting factor.

Unfortunately, fonts sizes must be specified by the half point. Rounding up
slightly may work out; otherwise round down. The bold numbersin a
column should add up: line length plus margins should be the paper width.
Similarly, text area height plus top and bottom margins should equal the
paper height. Before making such a change, save a copy of the file to a safe
location. Then select the entire book (Ctrl+A) and then effect the change
using Layout > Page Setup. Good luck with this. | have done it several
times, and the real issue is font sizes that don’t come from Normal, Heading
2, etc.

Poetry Anthology

One of my interrupters has been to publish the Century Edition of This
Singing World, originally published by Louis Untermeyer in 1923 and 1926.
The previous sections should cover the use of MS Word, when you write
“The Great American Novel.” However, when you care very much about
pagination and presentation, you need more. I’ll talk about how I did it for
this poetry anthology. This was a labor of love and required substantial
technological savvy — read on to avoid various false paths that | took.

Obtaining the Contents. | scanned all the text, and sent it through the
optical character recognition (OCR) software that came with my scanner. |
then had to correct numerous errors and perform substantial formatting. |
also had to figure out how to create the two indexes for the book, plus a
Table of Contents that includes the names of the poets. | saved all the
images of the scanned pages for reference; all the illustrations were saved
into separate files. | edited each image in Photoshop Elements to crop and
clean it up. An essential step, to get rid of the off-white background of these
black and white images: Ctrl+Alt+B > Newspaper.

Lower Case L (I) vs. Upper Case i (I). That’s Calibri — now Sitka Heading:
Lower Case L (1) vs. Upper Case i (I). In Calibri, the lower-1 is slightly
taller than the upper-I, but difficult to distinguish unless adjacent. When
you look carefully at Sitka Heading, the difference is clear. The scanner
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messes these up occasionally, usually replacing lower-1 with upper-I, but
sometimes the other way around.

MS Word does not find a lone upper-I reliably. To search the book for this
issue, I used the find command in Acrobat Reader, first selecting the option
to be case-sensitive from the search box. For each error, I listed the page
number, poem, stanza and line - then fixed them all in Word.

Quotation Marks and Apostrophes. On the keyboard, double (") and single
(') quotes are vertical. However, MS Word automatically converts them to
curly quotes. To reject this conversion, reverting (‘) or (') to ('), type the
character and then use Crtl+Z before doing anything else.

On the keyboard, the apostrophe is the same as the single quote.
(Computer nerds often use the accent grave (°) character as a left single
qguote, but this is not acceptable in a book — or anywhere, in my judgment.)

Curly quotes are different on the left and the right; the apostrophe is the
right single quote. Look at these examples:

1. “Now is the time...”
2. ‘for all good men...
3. ‘Tisn’t the season to be jolly.

Word'’s conversion for quotes is usually correct, as in examples (1) and (2).
The apostrophe is a single quote on the keyboard, and it gets converted
correctly in the middle or end of a word (isn’t). However, at the beginning
of the word (‘Tis, a contraction of “It is”), Word incorrectly provides a left
single quote — how could it know? The way to fix this is to copy (Ctrl+C) a
right single quote or apostrophe, and paste it (Ctrl+V) over the bad one, to
fix it ('Tis).
When you paste in scanned text, you can use the replace function to turn
straight quotes into curly quotes, for example, changing space-vertical-
quote (") to space-curly-quote ( “). Another trick is to change all straight
single quotes to percents (%) — readily identifiable — and work on them.
However, replace performs quote conversions, so you need to do individual
copies, as described above, to fix leading quotes — get one into the buffer,
and work through the whole book using Find.

Another idea: to get ('), type (x’) and delete the x. A similar trick can be used to auto-

convert an n-dash (-) to an m-dash (=): when some other rule does not interfere, space-

x-space ( x ) after the dash converts it — then delete unwanted text.
Another way: use Replace to change vertical quotes (') in the file with (%'). As we know,
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this will result in (%’) in the file, whether the original was straight or either curly, so you

probably don’t want to Replace All. Then Replace % with a null string. Get creative!
One Poem — Horizontal Alignment. In This Singing World, each poem is
roughly centered as a whole on the page. However, individual lines are
usually at or indented from the left margin of the poem (as opposed to the
page). | chose to do this with a 1 x 1 table, centered on the page. Then each
line of the poem is a paragraph within this page:

e A poem is often presented with a pattern of line indentations,
perhaps with odd numbered lines at the table left margin, and even
lines indented a little. | use five spaces for such an indent. Here is an
example, with the table within the border:

“I have answered three questions and that is enough,”
Said his father; “don’t give yourself airs!

Do you think I can listen all day to such stuff?
Be off, or I'll kick you downstairs!”

Lewis Carroll

e After creating the one-box table, use Table Properties to

1. First set the border (usually None, but dashes here), and then

2. Center the whole table (you’ll find this order important).

e Paste (or type) in the lines for the poem, concluding with the name of
the author:

1. Format every line of the poem with a hanging indent of 0.5”
and no space (0 pt) before or after it. Any lines that don’t fit
will be indented more than a five-space indent.

2. Format the author with italics, right aligned, 6 pt before and
0 pt after.

“l have answered three questions and that is
enough,”
Said his father; “don’t give yourself airs!
Do you think | can listen all day to such stuff?
Be off, or I'll kick you downstairs!”

Lewis Carroll

e Next, position the pointer on the right edge of the table until it
becomes two vertical bars with one arrow pointing left and another
right. Drag the right edge of the table to the left. Above, | went too
far, and the first line wrapped — notice the hanging indent.
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“I have answered three questions and that is enough,”
Said his father; “don’t give yourself airs!

Do you think | can listen all day to such stuff?
Be off, or I'll kick you downstairs!”

Lewis Carroll

e Dragging it back just to the first point where no line wraps, produces
the desired presentation of these lines, above.

e |f the poem is in multiple tables, adjust the width of each table so that
lines are properly aligned at the left edge, across the whole poem.

One Poem — Vertical Tightening. The best situation is when the whole
poem will fit on one side of one page. Typically, the poem starts with a
blank line between stanzas, with the default line height (11.5 pt for Media
T). To gain vertical space, the first thing to try is to reduce the blank lines to
8 pt, easily done from the menu. While a smaller size can be typed into the
menu, | find it easier to change all the first lines of stanzas to 6 pt (or less in
an extreme case) — and then delete the blank lines. Be sure to apply any
such change consistently, across the entire poem; for example, keep
uniform space between stanzas for the whole poem, except possibly before
the first. The space before the author line can be reduced to 3 or 0 pt,
especially if the last line of the poem is short, as in the example above.
Once, | put the author onto a short last line.

When the poem will require multiple pages, it is possible to let the table

simply flow onto the next page. However, when | had a Heading style inside

the table, | ran into problems, including:
Piling-up Problem: Poems would print into the top and bottom margins; the bottom of
a poem would disappear; | had as many as five poems pile up on top of each other; and
some text printed to the left of narrow poems. | had been using Office Home and
Student 2010; in desperation, | bought the 2021 version. With typical Microsoft
“change for its own sake,” the interface has differences, but | have discerned little
difference in the underlying functions | use — except those **&(*&"%s had disabled the
built-in help for 2010. | found no improvement with the piling up problem. Headings
now have gadgets of unknown function attached — they get in my way.

If such a problem occurs, break up the poem into multiple tables. End the

first page with a page break (or section break to a new page). | find that a

second table is fine, flowing to subsequent pages; but if there is trouble, we

know what to do.

Top of a Poem. Each poem starts with its title. For a while, | used a new
style, Poem, for the title of the poem. However, Word did not allow me to
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refer to that title. | switched to Heading 4 (modified to 15 pt bold Sitka
Heading), to which Word would refer, but still not place into the Table of
Contents. | need references on the Notes at the end of the book to poem
headings.

More Vertical Tightening. When a page break won’t fit on the current page:

e A page break usually comes with a couple of extra blank lines —
remove them.

e |f plain text precedes the page break, delete its paragraph ending, so
that the page break is attached to the paragraph —in this case, the
page break will take up no extra space on the page being ended. (Do
make sure the paragraph of the page break includes no space before
or afterit.) This trick may also work for a preceding image.

e |f the page break follows a table, it will be its own paragraph on the
ending page. This cannot be avoided, but reduce the font size of the
paragraph to 8, 4, or even 1 point. Again, make sure the paragraph
includes no space before or after it.

e For this type of work, you’ll need to repeatedly go into Show 9 mode
(Home > 9]) to see what is going on — and then into Hide 9 mode to
see the effect. The same techniques apply to text lines and blank
lines between poems.

Index and Table of Contents

Index entries must be inserted manually into the text on the page. Heading
1, 2 or 3 will insert the heading into the Table of Contents (TOC). That’s fine
for Heading 1, but not for 2 or 3. The original books include the author of
each poem, in italics, on the line in the TOC. To obtain that, | had to
manually create each line for the TOC in the text on the page, as for an
index. Microsoft documents these features online —and in the Help, if you
have it! = I'll only mention the features | use.

Each manual TOC and index entry is created as a field, a technical term
within a MS Word document. In normal Hide 9 mode, a field is not
displayed. Most fields are displayed when you go into Show §] mode. Each
field is bounded by special characters that look like braces — but you cannot
type them. To create a field from scratch, use Insert > Quick Parts > Field,
and select the correct field type: XE for an index entry, or TC for a TOC
entry. (If you are running Word in a narrow window, you won’t see Quick
Parts — it should be the first/top icon after Text Box.)
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Poem Template. | created a separate Poem.docx to contain only a template
for a new poem. Here itis in Hide 9] mode:

Poem

Text...
Author

And in Show 9 mode — this one is an image to show the fields:

Of course, | actually had the border set to None, instead of the dashed line
shown here. The raised dots indicate spaces. To use this template:

1. Copy the Poem title, the table and at least one of the following blank
lines into the book file.

2. In Show 9 mode, paste the text of the poem into the table, replacing
“Text...”.

3. Paste or type the poem title and the author’s name into those
locations. Do not put a heading (poem title) inside the table — that
causes multiple problems, especially when the table expands to a new
page.

4. Update the three index fields on the end of the title line.

a. Replace “t” with the title. Only for an XE field beginning with
“t”, move any article to the end. For example, “An Example”
becomes “Example, An”.

b. Replace “F L” with the author’s name. Only for a TC field, this
value should be in italics; be sure there is no space between the
tab and this value.

c. Replace “L, F” with the author’s name, last name first.
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The size of the font on these fields does not affect the page. Because |
don’t want these fields to fill up the page in Show 9 mode, | set them
to 8 pt.

The two blank lines after the table are crucial, for these reasons:

e [f you copy the table only, MS Word copies the contents of the cell,
not the formatted table.

e We want a blank line after the table to assure a following table won’t
butt up against it.

Index Entry (XE) field. The index entry, enclosed in double quotes, follows
the XE identifier, in “First:Second” format. XE has many options and
features, but the only one | use is \f, flagging the index to which this index
belongs:

“A” The index of authors, entered “last-name, first-name; title”.
“T” The index of titles, entered “Title: first-name last-name”.
For this index only, use italics on the author’s name.

Enter or paste in the correct values. An extra leading or trailing space
should be ignored — a good thing, because MS Word liberally inserts them.

Table of Contents Entry (TC) field. The TOC entry, enclosed in double
quotes, follows the TC identifier, in “title>firstname lastname” format.
That arrow is a tab character. Depending on the vagaries of horizontal
spacing, the tab may display as lots of space or, as in the image above, be
quite narrow. (To enter a tab into a table, use Ctrl+Tab.) The options | used
for TC:

\f “Q” distinguishes my TOC entries from Heading TOC entries.

\l 2 (€) a level 2 (Heading 2 equivalent) entry. | also use \¢ 3.
Enter or paste in the correct values.

Assure there is no space after the tab (), as it would print.

If there is no author, use a period (.) right after the tab.

Inserting an Index. An index can be created with an INDEX field using Insert
> Quick Parts > Field..., or using References > Insert Index. Normally, the
index field itself is not shown; the contents of the index are shown. To
toggle between showing the field instead of the index press Alt+F9. Here
are the contents of the fields | used to insert each of my indexes:
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Authors:  INDEX\e" "\c"2"\z "1033" \f "A"

Titles: INDEX\e"  "\c"2"\z"1033" \f"T"
\e a default supplied by MS Word.
\c 2 two-column index.

\z 1033 a default supplied by MS Word.
\f flags the entries to be included.

Inserting a Table of Contents. The TOC should be created with References >
Table of Contents and then selecting a style. In my experience, entries
created by Heading tags are always included, whether or not the \f switch is
supplied. After Alt+F9, | updated to:

Field: TOC\f"Q" \o "1-3"\w \x \h
\f'Q" Selects my manual entries.

\o "1-3"  Output levels one 1 through 3.

\w Preserve tab entries in table entries (I need this).
\x Preserve line breaks within entries (failed, so unused).
\h Inserts TOC entries as hyperlinks —a good deal.

Format the Table of Contents.

N

Important: locate the pointer within the TOC.

Bring up the Styles menu: Home > Styles (lower right corner).

Clicking on a style will change the text in the document — that’s not
what we are here for!

Scroll and right-click on TOC 1. Change the style as needed to produce

these attributes:
Font: Sitka Heading, Do not check spelling or grammar, Space
Before: 3 pt
After: 1 pt
Tab stops: 4.29", Right,Leader: ..., Style: Automatically update, Hide until used,
Show in the Styles gallery, Priority: 40
Based on: Normal
Following style: Normal
Modify TOC 2 as needed to produce these attributes:
Font: Sitka Heading, 10 pt, Do not check spelling or grammar, Indent:
Left: 0.19"
Hanging: 0.24", Space
After: O pt
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Tab stops: 2.3", Left,Leader: ... + 4.29", Right,Leader: ..., Style: Automatically
update, Hide until used, Show in the Styles gallery, Priority: 40

Based on: Normal

Following style: Normal

6. Modify TOC 3 as needed to produce these attributes:
Font: (Default) Sitka Heading, 9 pt, (Asian) Japanese, Indent:
Left: 0.31", Space
After: 0 pt
Tab stops: 2.3", Left,Leader: ... + 4.29", Right,Leader: ..., Style: Automatically
update, Hide until used, Show in the Styles gallery, Priority: 40
Based on: Normal
Following style: Normal

Problems in the TOC or an Index:

A long author’s name, one that flows into the space for the page number,
won’t format correctly in the TOC. | chose to set the tab for the author to
permit Henry Wadsworth Longfellow, the longest name, to fit before a
three-digit page number.

A long title of a poem, one that flows into the space for the author’s name,
won’t format correctly in the TOC. The solution for this is two lines:

TC " How They Brought the Good News " \f “Q” \l 2 \n

TC "->from Ghent to Aix 2 Robert Browning" \f “Q” \I 2

How They Brought the Good News

from Ghent to AiX .......ccecervieviennennne Robert BrOWning ........c.cceeeeveeeeveennnee. 191
\n on the first line says to not include the page number. Straight and curly
quotes are treated the same. TC/TOC automatically sets a tab near the
beginning of the line, and we use this to indent the second line.

A short title of a poem, which does not reach that first tab, will not format
correctly in the Index or TOC. Append one or two non-breaking spaces
(Ctrl+Shift+Space) or a tab (Ctrl+Tab) after the title to fix this problem.

Required Steps before Publication:

Make sure Hide 9] mode is in effect, as Show 4] mode temporarily changes
page numbers!

My chapters begin on odd-numbered (right-side) pages. If you have this, or
any other page-siding issues, check them now. Make sure that the even-
numbered page at the end of the previous chapter is there — don’t use “Next
Odd Page” or the like, or you won’t have a footer on an even-numbered
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blank page that may be generated. Instead, insert a page break before the
page-section break for the new chapter.

Update any “fields” (references to page numbers, headings, etc.) so that
they are accurate. We need to do this for each “story” in the document.
The largest story is the body of the document. We can update that with:

Ctrl+ A — F9

For each table of contents (probably one, but | have nine for Bidding Tools),
specify in the pop-up box to update the whole thing.

Other stories include each table, header, footer, text box, etc. The best idea
is to not use any references in such contexts. | have one table chock full of
them, at the end of Bidding Tools. | selected the whole table from its upper
left corner, and pressed F9 to update it.

Checklist Specifically for This Singing World:

O Verify that page 1 is truly an odd (right-hand) page — that the TOC ends on an even numeral ~xii.
O Inthe TOC, verify that each section (Heading 1) begins on an odd page.
[0 These poems with related images should begin on an odd page:
A Foreword ~5
Sea-Fever ~17
The Song of the Ungirt Runners ~35
Seumas Beg ~83
The Shepherdess ~89
Dolphins in Blue Water ~113
The Satyrs and the Moon ~131
Adventure ~135
To Helen ~141
The Ballad of John Silver ~171
The Highwayman ~201
Invictus ~323
[0 These poems with related images should begin on an even page:
O Climb ~320-image facing
O Page headings:
O No Heading on Section Title (Heading 1) page.
[0 Section Heading begins on second odd page (with first poem).
O This Singing World heading on all even pages.
O Full book checks:
Footnotes do not slip to next page.
Poems are horizontally centered and tight.
Poems and footnotes are placed well vertically.
Empty space that could be condensed to save two pages.
Poem line indents correspond to original.
Poem stanza breaks correspond to original.

OoOoo0OoOooOooOoooao

OoOoooano

Required Steps before Publication (before | found the better way, above):
Make sure Hide 9] mode is in effect, as Show 9 mode temporarily changes page numbers!

1. Update each Index:
a. Right click inside the Index > Update Field. Repeat for the other index.
b. Press Alt+F9 to edit the INDEX field.
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c. Highlight the entire index field and change it (as text) to 12 pt, an extra step necessary to get the
real change to “take.” Repeat for the other index.
d. Highlight the entire first index field and change it (as text) to 9 pt. Repeat for the other index.
e. Press Alt+F9 and observe the change.
2. Update the TOC:
f.  Right click in the TOC > Update Field > ® Update entire table.
3. Update all the page number references in the book. Right click on the field > Update Field:
g. Inthe Introduction to the Century Edition on page 1.
h. In the footnote to An Unrhymed Limerick ~274.
i.  Onthefirst line of each of the 48+ Notes.

Publishing a Print Book
Since my plan is to give away the PDF of my book, and to offer print editions
at cost, my requirements differ from those of most writers:

e On-demand publishers price differently. Assuming comparable
quality, | want the lowest minimum price, including shipping.

e The product must be of decent quality.

e |'d like as many people as possible to encounter my books, which
certainly won’t happen via my site alone.

For these purposes, amazon.com wins, hands down. This is how | published
the poetry in May 2022:

This Singing World — Century Edition, US Trade size, hardcover (perfect-
bound on fabric without signatures), 380 pages, originally $16.77 with
free Prime shipping. The original print cost was $10.06.

This Singing World — Favorites from the Century Edition, Letter size,
paperback, 56 pages, originally $3.58 with free Prime shipping. The
original print cost was $2.15.

The minimum (no-royalty) price, which applies here, is two-thirds higher
than the current print cost. | like glossy covers — the matte finish feels tacky.

Unfortunately, Amazon’s system sometimes combines one of my editions
with a more-expensive, used, original edition (not even the superior revised
edition). If you are interested, go to my site, check out the free PDFs, and
then use one of my links to get to the correct Amazon page:

https://3nt.xyz > Ideas > Poetry

Effective 20 June 2023, Amazon KDP now charges more to print on paper
trimmed larger than US Trade (specifically, higher than 9.0” or wider than
6.12”, but don’t go bigger than 6.0”) — they used to charge the same for all
trim sizes. | was all ready to go with Executive, but | sized down again. Over
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some page threshold in the rear-view mirror, the page cost for US Trade is
0.012 per page, and 0.017 for larger sizes. The minimum sales price is 5/3
(1.67) times the print cost.

Before 20 June 2023 Starting 20 June 2023
Cover | Pages | Media | Fixed | Pages | Print| Total | Fixed | Pages | Print | Total
Hard 380 T 5.50 456 | 10.06 | 16.77 5.65 456 | 10.21 | 17.02
Paper 56 P 2.15 - 2.15 3.84 2.84 - 2.84 4.74
Paper | 286 T - - - - 1.00 3.43 4.43 7.39
Paper | 286 X - - - - 1.00 4.87 5.87 9.78

Amazon’s publishing options are sufficient for me. | use their free ISBN; I'll
have exposure on amazon.com, but only there. | have ordered copies at the
printing cost, without free Prime shipping (515.94 on 5 hardcovers, plus 3.15
sales tax). It's often better to just buy as a customer, and ship it direct. Of
any increase in price, Amazon takes 40%. Because our bridge bookseller
takes half the sales price, self-distributing jacks up the price (or take a loss).

| have a couple of books from xpress.lulu.com, and they are solid. Their
price is competitive only without an ISBN, with books available only directly
from Lulu. Lulu does have many more publishing options.

By all means, read over what follows. Your book should be ready to publish
(for a proof copy), before continuing:

Get a KDP Account. Type KDP into your search engine, and the first hit
should be Amazon Kindle Direct Publishing (kdp.amazon.com). | signed up
with my name, rank and SSN —it’s like getting a job, they need to know
about paying you.

Register the Book. Here is what | entered for my first book:

Cover: Paperback

Language: English

Book Title: This Singing World - Favorites from the Century Edition
Subtitle: Edited by Pete Matthews Jr

Series: N/A

Edition Number: N/A (blank)

Author: Louis Untermeyer

Contributor Pete Matthews Jr

Description:

The 1926 copyright on the hard-to-find Revised Edition of Louis Untermeyer's This
Singing World has expired, so | am allowed to provide here these Favorites from the
Century Edition of the classic anthology that five generations of my family have enjoyed.

This book is being sold at cost. A digital PDF version is available for free on my web site,
3nt.xyz, at Ideas > Poetry. Check it out!
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Publishing Rights: ® This is a public domain work
Keywords: Poetry Poem Children Limericks Famous Historical Rhymes
Categories: Nonfiction > Poetry > American > General
Juvenile Nonfiction > Poetry > Humorous
Adult Content:® No
[Save and Continue]

ISBN: ©® Get afree KDP ISBN *

Publication Date: N/A (blank)

Interior & paper: Black & White interior with cream paper
Interior trim size: 8.25x 11 in **

Bleed settings:no bleed
Cover finish: Glossy (Matte looked fine, but felt tacky)

* | investigated their source: $99 for your own, portable ISBN.

** | decided to upsize Media T to Letter size, as in the earlier table.

At this point | was supposed to upload my print-ready manuscript (PDF) and
my cover. | was just exploring and did not have a cover yet, so | stopped:

[Save as Draft]

Build a cover. You’ll want to read about this stuff yourself. | chose to
download a template for the book with the specs above. | then investigated
ways to build the cover. Of the many tools, | have two already installed on
my computer. | started by updating the free and powerful Gimp program to
the latest edition, and firing it up. As usual, | was totally bemused and
powered it down. I’'m not an artist, and | don’t want to learn to use this
tool. Next up, Photoshop Elements, which is all | need for photos. This tool
is not ideal for artwork, but | built a simple cover from images related to the
book. Since the book contents are a century old, | don’t want glitz, anyhow.
KDP may have better cover building help somewhere, but I’'m done for now.

Upload the manuscript and cover file. The process of uploading each file is
simple, but takes a while.

Caution: Upload only PDF files. Anything else is unreliable.

For the manuscript file, the upload process will accept your .docx file
without complaint — | did this once by accident. My centered tables
centered headers/footers no longer lined up. After a period of panic, |
checked this and uploaded the correct file. Think about it: a PDF is a print-
specific file, intended to just work. A Word file depends on what created it
and what is interpreting it: Word 2010, Word 2021, whatever Amazon is
using, etc.
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Launch Previewer. Once both uploaded files have clearly been processed,
launch the Previewer, the next item on the web page. This is a great tool for
checking out the formatting of the book. First, you see your cover, which
should have the back on the left and the front on the right. Clicking the
angle-right (>) moves two pages ahead, showing the blank inside of the front
cover on the left, and the first page of your manuscript on the right. Riffle
through the whole book, checking that all he odd page numbers are on the
right, headers and footers are at consistent locations and change with
chapters as you designed, any illustrations that occupy a whole page are
centered as you wish, etc. Take notes and keep on going.

If you need to make change, click the button to exit. Fix the document in MS
Word, save it as a PDF, and upload it again.

Once the Previewer shows a “perfect” file, click Approve.

Publish the Book. A day or three after clicking the button to publish, it will
appear on amazon.com — eligible for free Prime shipping. You will get an e-
mail with a link to the book and other information. It will tell you how to
order author copies, at the printing cost. However, you will have to pay for
shipping; for a small number of copies, you will find it costs less to pay full
price on the book with free Prime shipping.

Revising the Book. At publication time, | had two books at the same time,
and two files for each book (print and narrow-margin web). Things got out
of whack, and | made some bad publishes. Ideally, do one file “perfectly,”
and then move on to alternative formats. If one of those formats is e-book
or Kindle, you will be prompted to start immediately after clicking Publish.

On the main KDP page, by the published book on the lower right, you will
see a three dots (. . .) icon —click that and select Unpublish. The web page
will stay up, but no stock will be available (although prior orders or stock of
third parties [global distribution] cannot be stopped). Fix and republish.

Caution: You cannot unpublish a book while a published version is
being reviewed.

Publish with Reedsy

Reedsy is a free editor for preparing a book for publication that will read in your Word (.docx)
file. When you are ready, you pick your page size and target, and Reedsy prepares the book for
publication. The targets are PDF (for print) and Epub for digital readers. These are the
supported page sizes:

Pocket 4.25" x 6.87” - mass-market paperback
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Reedsy * 5” x 8"
Digest * 5.5” x 8.5” - aka Junior
Trade ** 6” x9” - aka US Trade

*  Supported for paperback by Amazon KDP.
** Supported for paperback and hardcover by Amazon KDP.

Reedsy won’t handle either a size larger than US Trade or my specialized TOC for poetry. | did
not try Reedsy for my bridge book, either. For more info, see https://blog.reedsy.com/how-to-
format-a-book/.

Formatting for Kindle

It is not required to publish in Kindle or other electronic format when doing a print book at
Amazon. If you want to make money, publishing on Kindle makes sense. Since I’'m giving away
PDFs on my site — and they can be read on a Kindle — I’d be nuts to go to the extra work. The
info below, was assembled from research, not experience; it might be useful to others.

Publishing in Kindle format may wreak havoc on carefully formatted tables. Pagination control
is out the window, for sure. Worse is my use of the Cards font. A Kindle certainly does not have
that. Even if it's possible to install it, it might not work as desired. (It's fine in a PDF that
contains a copy of the whole font.)

The trick will be to write the whole book in a single Unicode font. The two Windows 10 fonts
that | found to include the required outline (white) heart and diamond symbols, in addition to
the solid (black) space and club symbols are:

Arial Unicode MS — symbols slightly smaller; text bolder than Calibri
Cambria Math — symbols significantly smaller; serif

Yu Gothic — symbols slightly larger; text fainter than Calibri

Yu Gothic Ul — symbols significantly larger; text sl. bolder than Calibri

Yu Gothic Ul is a User Interface font that has been compressed so that it can seamlessly replace
other such fonts. Arial Unicode MS looks like the best bet. If the symbols are slightly larger than
the rest of the font, they may cause extra space between lines when used in a paragraph.

Anyhow, the point is to produce the entire book in the same font, including the suit symbols.
The fonts above have the symbols we need at the prescribed locations:

U+2660 = black spade suit
U+2661 = white heart suit
U+2662 = white diamond suit
U+2663 = black club suit

In MS Word 2010, use Insert - Symbol - More Symbols, and scroll way down. You'll see the
Unicode number from the chart above, for the correct symbol. Of course, once you have the
correct symbol in the book, just copy it around. These symbols are acceptable, but inferior in
appearance to the non-Unicode Cards font symbols.

Unfortunately, although most fonts are Unicode, most of those do not contain the required
four symbols. Many contain the black spade and club symbols, but not the white heart and
diamonds. (Many fonts do contain a white diamond at the wrong location; avoid those fonts.)
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Using a single Unicode font should enable the document to display reasonably on the end
user's Kindle — if the kindle has a Unicode font containing our symbols — and if the user
selects that font. This is reportedly possible on all recent Kindles, the Georgia font being
appropriate for a first try. (However, Georgia on Windows does not have suit symbols). The
appearance of the symbols is wholly dependent on the Kindle font. It would be appropriate to
describe a test in the front matter of the book.

More info is out on the web. | found the work of Tim C. Taylor to be helpful, for example,
https://timctaylor.wordpress.com/2014/02/24/kindle-support-for-unicode-pt2-how-to-use-unicode.

For a while | had a Kindle, but | gave it to my daughter. | got it to read library books, for which it
was kind of a PITA. Reading library books was much better on my Pixel 3 smartphone (now
Pixel 7), and it fits in my pocket, too. Now | have a 10-inch Samsung tablet for use with a digital
piano, and | have used it for proofreading, where the big screen helps. | still like my phone best
for reading —it’s usually with me.
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